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MSP430FR5969 LaunchPad™ Development Kit
(MSP‑EXP430FR5969)

The MSP-EXP430FR5969 (or the "FR5969 LaunchPad") is an easy-to-use evaluation module (EVM) for
the MSP430FR5969 microcontroller. It contains everything needed to start developing on the MSP430
FRAM platform, including on-board emulation for programming, debugging, and energy measurements.
The board features buttons and LEDs for quick integration of a simple user interface as well as a super
capacitor (super cap) that enables standalone applications without an external power supply.

Figure 1. MSP-EXP430FR5969
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Getting Started

1.1

Introduction
MSP430™ ultra-low-power (ULP) MCUs with embedded Ferroelectric Random Access Memory (FRAM)
technology now join the MCU LaunchPad™ Development Kit ecosystem. The MSP-EXP430FR5969 (or
the "FR5969 LaunchPad") is an easy-to-use evaluation module (EVM) for the MSP430FR5969
microcontroller. It contains everything needed to start developing on the MSP430 FRAM platform,
including on-board emulation for programming, debugging, and energy measurements. The board features
buttons and LEDs for quick integration of a simple user interface as well as a super capacitor (super cap)
that enables standalone applications without an external power supply.
Rapid prototyping is simplified by the 20-pin BoosterPack™ plug-in module headers, which support a wide
range of available BoosterPacks. You can quickly add features like wireless connectivity, graphical
displays, environmental sensing, and much more. You can either design your own BoosterPack or choose
among many already available from TI and third-party developers.
The MSP430FR5969 device features 64KB of embedded FRAM, a nonvolatile memory known for its ultralow power, high endurance, and high-speed write access. The device supports CPU speeds up to 16 MHz
and has integrated peripherals for communication, ADC, timers, AES encryption, and more – plenty to get
you started in your development.
Free software development tools are also available - TI's Eclipse-based Code Composer Studio™ IDE
(CCS) and IAR Embedded Workbench™ IDE (IAR), and the community-driven Energia open-source code
editor. More information about the LaunchPad including documentation and design files can be found on
the tool page at www.ti.com/tool/msp-exp430fr5969.

1.2

Key Features
•
•
•
•
•
•

1.3

Kit Contents
•
•
•

1.4

MSP430 ultra-low-power FRAM technology based MSP430FR5969 16-bit MCU
20-pin LaunchPad standard that leverages the BoosterPack ecosystem
0.1-F super capacitor for standalone power
Onboard eZ-FET emulation with EnergyTrace++™ Technology
Two buttons and two LEDs for user interaction
Backchannel UART through USB to PC

1 x MSP-EXP430FR5969
1 x Micro USB cable
1 x Quick Start Guide

First Steps – Out-of-Box Experience
An easy way to get familiar with the EVM is by using its pre-programmed out-of-box demo code, which
demonstrates some key features of the MSP-EXP430FR5969 LaunchPad.
The out-of-box demo showcases MSP430FR5969's ultra-low power FRAM by utilizing the device's internal
temperature sensor while running only off of the on-board Super Capacitor.
First step is to connect the LaunchPad to the computer using the included Micro-USB cable.
The RED and GREEN LEDs near the bottom of the LaunchPad toggle a few times to indicate the preprogrammed out-of-box demo is running.
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Using the out-of-box demo GUI, included in the MSP-EXP430FR5969 Software Examples, the user can
place the LaunchPad into two different modes:
• Live Temperature Mode
This mode provides live temperature data streaming to the PC GUI. The user is able to influence the
temperature of the device and see the changes on the GUI.
• FRAM Logging Mode
This mode shows the FRAM data logging capabilities of the MSP430FR5969. After starting this mode,
the LaunchPad will wake up every five seconds from sleep mode (indicated by LED blink) to log both
temperature and input voltage values. After reconnecting to the GUI, these values can be uploaded
and graphed in the GUI.
A more detailed explanation of each mode can be found in Section 3.

1.5

Next Steps – Looking Into the Provided Code
After the out-of-box demo, more features can be explored. The hardware features on the LaunchPad are
shown in Section 2, and the provided code examples and how to use them are in Section 3. More details
and documentation can be found at http://www.ti.com/tool/msp-exp430fr5969. Code is licensed under BSD
and TI encourages reuse and modifications to fit your needs.
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2

Hardware
Figure 2 shows an overview of the LaunchPad hardware.

Figure 2. EVM Overview
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Block Diagram
Figure 3 shows the block diagram.
Micro-B
USB

LED
Red, Green

ESD
Protection

Crystal
4 MHz

Debug
MCU

3.3-V LDO
UART, SBW to Target

Power to Target

14-pin JTAG
header

100-mF
SuperCap

Power Selection
Reset
button

Crystals
HF (MHz)
and
32.768 kHz

Target Device
MSP430FR5969

20-pin LaunchPad
standard headers

User Interface
2 buttons and 2 LEDs

Figure 3. Block Diagram

2.2

MSP430FR5969
The MSP430FR5969 is the first device in TI's new ULP FRAM technology platform. FRAM is a cutting
edge memory technology, combining the best features of flash and RAM into one nonvolatile memory.
More information on FRAM can be found at www.ti.com/fram.
Device features include:
• 1.8-V to 3.6-V operation
• Up to 16-MHz system clock and 8-MHz FRAM access
• 64KB FRAM and 2KB SRAM
• Ultra-low-power operation
• Five timer blocks and up to three serial interfaces (SPI, UART, or I2C)
• Analog: 16-channel 12-bit differential ADC and 16-channel comparator
• Digital: AES256, CRC, DMA, and hardware MPY32
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Figure 4. MSP430FR5969 Pinout
To compare the various MSP430 derivatives, download the MSP430 Product Brochure (SLAB034), which
is also available from http://www.ti.com/msp430. The brochure has a table that lets you see, at a glance,
how the families compare, and their pricing. This document is frequently updated, as new MSP430
derivatives become available.
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Measure MSP430 Current Draw
A specific jumper J9 is placed on the LaunchPad to allow for measuring current draw of the
MSP430FR5969 device. The current measured includes the FR5969, and any current drawn through the
BoosterPack headers and jumper J1.
To measure ultra-low power, follow these steps:
1. Remove the J9 jumper; attach an ammeter across this jumper.
2. Consider the effect that the backchannel UART and any circuitry attached to the FR5969 may have on
current draw. Maybe these should be disconnected at the isolation jumper block, or their current
sinking and sourcing capability at least considered in the final measurement.
3. Make sure there are no floating input I/Os. These cause unnecessary extra current draw. Every I/O
should either be driven out or, if an input, should be pulled or driven to a high or low level.
4. Begin target FR5969 execution.
5. Measure the current. (Keep in mind that if the current levels are fluctuating, it may be difficult to get a
stable measurement. It is easier to measure quiescent states.)

2.2.2

Clocking
The FR5969 LaunchPad provides external clocks in addition to the internal clocks in the device.
• Y4: a 32-kHz crystal
• Y1: an unpopulated region that supports HF crystal or resonator (4 to 24 MHz)
The 32-kHz crystal allows for lower LPM3 sleep currents than do the other low-frequency clock sources.
Therefore, the presence of the crystal allows the full range of low-power modes to be used.
For more information about internal clocks and how to use the 32-kHz or HF crystal, see the
MSP430FR59xx family user's guide.
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2.3

eZ-FET Onboard Emulator With EnergyTrace™ Technology
To keep development easy and cost effective, TI's LaunchPad development tools integrate an onboard
emulator, eliminating the need for expensive programmers.
The FR5969 LaunchPad has the new eZ-FET emulator (see Figure 5), a simple and low-cost debugger
that supports almost all MSP430 device derivatives.

Figure 5. eZ-FET Emulator
The eZ-FET provides many features that make debugging an easy experience. Included is a
"backchannel" UART-over-USB connection with the host, EnergyTrace Technology, and a distinct isolation
from the target side microcontroller.
The eZ-FET hardware can be found in the schematics in Section 6 and in the accompanying hardware
design files. The eZ-FET software and more information about the debugger can be found at the eZ-FET
lite wiki.
2.3.1

Emulator/Debugger
The eZ-FET is an on-board emulation solution for MSP430 microcontrollers. It allows direct interfacing to a
PC for easy programming, debugging, and evaluation. The eZ-FET uses Spy-Bi-Wire (SBW) two-wire
protocol to interface with the MSP430 devices. These pins are the SBW RST and SBW TST pins located
on the emulator isolation block. More details on the isolation block can be found in Section 2.3.4.
The eZ-FET on-board emulation is supported by the MSP430 DLL and can be used with IAR Embedded
Workbench for MSP430 Integrated Development Environment (IDE) or Code Composer Studio (CCS) IDE
to write, download, and debug applications.
The debugger is unobtrusive and allows the user to run an application at full speed with hardware
breakpoints and single stepping available while consuming no extra hardware resources. The firmware for
the eZ-FET is field undatable, so any updates can be received as needed.
More information on SBW can be found in the MSP430 Hardware Tools User's Guide (SLAU278), and
information on the MSP430 DLL can be found at www.ti.com/mspds.
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Application (or "Backchannel") UART
The backchannel UART allows communication with the USB host that isn't part of the target application's
main functionality. This is very useful during development, and also provides a communication channel to
the PC host side. This can be used to create GUIs and other programs on the PC that communicate with
the FR5969 LaunchPad.
The pathway of the backchannel UART is shown in Figure 10. The backchannel UART (USCI_A0) is
independent of the UART on the 20-pin BoosterPack connector (USCI_A1).
On the host side, a virtual COM port for the application backchannel UART is generated when the
LaunchPad enumerates on the host. You can use any PC application that interfaces with COM ports,
including terminal applications like Hyperterminal or Docklight, to open this port and communicate with the
target application. You need to identify the COM port for the backchannel. On Windows PCs, Device
Manager can assist (see Figure 6).

Figure 6. Application Backchannel UART in Device Manager
The backchannel UART is the "MSP Application UART1" port. In this case, Figure 6 shows COM13, but
this varies from one host PC to the next. After you identify the correct COM port, configure it in your host
application, according to its documentation. You can then open the port and begin talking to it from the
host.
On the target FR5969 side, the backchannel is connected to the USCI_A0 module.
The eZ-FET has a configurable baud rate, therefore, it is important that the PC application configures the
baud rate to be the same as the rate configured on the USCI_A0.
The eZ-FET also supports hardware flow control, if desired. Hardware flow control (CTS/RTS
handshaking) allows the target FR5969 and the emulator to tell each other to wait before sending more
data. At low baud rates and with simple target applications, flow control may not be necessary.
Applications with faster baud rates and more interrupts to service have a higher likelihood that they cannot
read the USCI_A0's RXBUF register in time, before the next byte arrives. If this happens, the USCI_A0's
UCA0STATW register will report an overrun error.
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2.3.3

EnergyTrace™ Technology
EnergyTrace™ Technology is an energy-based code analysis tool set that is useful for measuring and
viewing the application’s energy profile and optimizing it for ultra-low power consumption. The
MSP430FR5969 device supports EnergyTrace++ (EnergyTrace + [CPU State] + [Peripheral States]) for
full access to the application energy profile as well as CPU and peripheral states.
By default, EnergyTrace technology is disabled in CCS. To enable EnergyTrace, click Window →
Preferences → Code Composer Studio → Advanced Tools → EnergyTrace™ Technology. Select the
"Enable" checkbox and the EnergyTrace++ setting for full functionality (see Figure 7).

Figure 7. EnergyTrace Technology Settings
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To fully enable the EnergyTrace++ setting, the ultra-low-power debug mode must be enabled. Right click
on the active project in the project explorer and click Properties. In the Debug section, enable "Ultra Low
Power debug/ Debug LPMx.5" option in the Low Power Mode Settings (see Figure 8). If this option is not
enabled, the EnergyTrace++ mode cannot capture data from the device.

Figure 8. Debug Properties
After the correct settings are chosen, the EnergyTrace window automatically opens when debug is started.
The EnergyTrace++ window has four separate tabs: Profile, States, Power, and Energy.
Table 1. EnergyTrace++ Debug Windows

12

EnergyTrace++
Debug Window

Description

Profile

Displays a compressed view of captured data and allows comparison with previous data

States

Real-time trace of the target microcontroller's internal states captured. Includes power modes and peripheral
on/off states.

Power

Dynamic power consumption of the target over time. A previous trace profile for comparison is yellow in color.

Energy

Accumulated energy of the target over time. A previous trace profile for comparison is yellow in color.
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These tabs allow you to see exactly what is happening in your application, and find power black holes. An
example application with the EnergyTrace++ windows is shown in Figure 9.

Figure 9. Debug Session With EnergyTrace++ Windows
After the EnergyTrace window is active, it can be controlled with the buttons in Table 2.
Table 2. EnergyTrace™ Technology Control Bar Icons
Enable or disable EnergyTrace Technology. When disabled, icon turns gray.
Set capture period: 5 sec, 10 sec, 30 sec, 1 min, or 5 min. Data collection stops after time has elapsed. However,
the program continues to execute until the Pause button in the debug control window is clicked.
Save profile to project directory. When saving an EnergyTrace++ profile, the default filename will start with
"MSP430_D" followed by a timestamp. When saving an EnergyTrace profile, the default filename will start with
"MSP430" followed by a timestamp.
Load previously saved profile for comparison.
Restore graphs or open Preferences window.
Switch between EnergyTrace++ mode and EnergyTrace mode

An example application using the MSP-EXP430FR5969 with EnergyTrace++ Technology is provided in
the application note: MSP430 Advanced Power Optimizations: ULP Advisor SW and EnergyTrace
Technology (SLAA603). For more details on EnergyTrace, refer to the Code Composer Studio v6.0 for
MSP430 User's Guide (SLAU157).
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Emulator Connection – Isolation Jumper Block
The isolation jumper block at Jumper J13 allows the user to connect/disconnect signals that cross from
the eZ-FET domain into the FR5969 target domain. This includes eZ-FET Spy-Bi-Wire signals, application
UART signals, and 3V3 and 5V power (see Table 3).
Reasons to open these connections:
• To remove any and all influence from the eZ-FET emulator for high accuracy target power
measurements
• To control 3-V and 5-V power flow between eZ-FET and target domains
• To expose the target MCU pins for other use than onboard debugging and application UART
communication
• To expose programming and UART interface of the eZ-FET so it can be used for devices other than
the onboard MCU.
Table 3. Isolation Block Connections
Jumper
GND
V+

Description
Ground
3.3-V rail, derived from VBUS by an LDO in the eZ-FET domain

RTS >>

Backchannel UART: Ready-To-Send, for hardware flow control. The target can use this to indicate whether 'it is
ready to receive data from the host PC. The arrows indicate the direction of the signal.

CTS <<

Backchannel UART: Clear-To-Send, for hardware flow control. The host PC (through the emulator) uses this to
indicate whether or not it is ready to receive data. The arrows indicate the direction of the signal.

RXD <<

Backchannel UART: the target FR5969 receives data through this signal. The arrows indicate the direction of the
signal.

TXD >>

Backchannel UART: the target FR5969 sends data through this signal. The arrows indicate the direction of the
signal.

RST

Spy-Bi-Wire emulation: SBWTDIO data signal. This pin also functions as the RST signal (active low)

TST

Spy-Bi-Wire emulation: SBWTCK clock signal. This pin also functions as the TST signal

USB Connector

eZ-FET

USB
in

out
LDO

eZ-FET
Emulator
MCU

Target
MSP430FR5969
MCU

BoosterPack Header

Spy-Bi-Wire (SBW)
Emulation

Application UART
USCI A0

3.3V Power

5V Power

BoosterPack Header

MSP430FR5969 Target

Isolation
Jumper Block

Figure 10. eZ-FET Isolation Jumper Block Diagram

14

MSP430FR5969 LaunchPad™ Development Kit (MSP‑EXP430FR5969)

SLAU535B – February 2014 – Revised July 2015
Submit Documentation Feedback

Copyright © 2014–2015, Texas Instruments Incorporated

Hardware

www.ti.com

2.3.5

14-Pin JTAG Connector
This EVM contains a footprint for TI's standard 14-pin MSP430 JTAG header. This connector can be used
as needed. For debug purposes, this connector offers 4-wire JTAG compared to the 2-wire Spy-Bi-Wire
from the eZ-FET. In certain use cases this can be advantageous. The MSP-FET or another MSP430
external debug tool such as MSP-FET430UIF or third-party tool can be used. This JTAG connector can be
used to power the system directly or can be used with external power. The MSP-FET tool supports
EnergyTrace™ technology and can perform the same measurements as the eZ-FET onboard emulator.
See Section 2.4 for more details on the JTAG system power requirements.

2.3.6

Using the eZ-FET Emulator With a Different Target
The eZ-FET emulator on the FR5969 LaunchPad can interface to most MSP430 derivative devices, not
just the on-board FR5969 target device.
To do this, disconnect every jumper in the isolation jumper block. This is necessary because the emulator
cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.
Next, make sure the target board has proper connections for Spy-Bi-Wire. Note that to be compatible with
SBW, the capacitor on RST/SBWTDIO cannot be greater than 2.2 nF. The documentation for designing
MSP430 JTAG interface circuitry is the MSP430 Hardware Tools User's Guide (SLAU278).
Finally, wire together these signals from the emulator's side of the isolation jumper block to the target
hardware:
• 3.3 V (V+)
• GND
• SBWTDIO
• SBWTCK
• TXD (if the UART backchannel is to be used)
• RXD (if the UART backchannel is to be used)
• CTS (if hardware flow control is to be used)
• RTS (if hardware flow control is to be used)
This wiring can be done either with jumper wires or by designing the board with a connector that plugs into
the isolation jumper block.
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Power
The board is designed to support five different power scenarios. The board can be powered by the eZFET or JTAG debugger, external power, BoosterPack power, or standalone super cap power.

Legend
eZ-FET
J3

J13

V+

Debug
Power
Domain

JTAG
Use

J2
J11

Super
Cap
J9

Super Cap
Power
Domain

Target and
BoosterPack
Power
Domain

J4

External

Charge

Bypass

Debugger

VCC

J12

GND
GND

External

Measure
Current

External
Power
Domain

J10

J5

Target
MSP430FR5969
Device

MSP430FR5969
target and
BoosterPack

GND

J1

GND
VCC

Figure 11. MSP430FR5969 LaunchPad Power Domain Block Diagram
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2.4.1

eZ-FET USB Power
The most common scenario is power from USB through the eZ-FET debugger. This provides 5-V power
from USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the target side of
the LaunchPad. Power from the eZ-FET is controlled by jumper J13. For 3.3 V, ensure that a jumper is
connected across the J13 "V+" terminal. The eZ-FET is a debugger, so J10 must be set to debugger for
power to reach the target MSP430FR5969 device.
For the power configuration diagram, see Figure 12.

2.4.2

14-Pin JTAG
When powering directly from the JTAG connector through the MSP-FET430UIF or other MSP430
debugger tool, ensure that jumper J10 is set to "Debugger." JTAG debugging can also be used with an
external power source, when J10 is set to "External," and some external power source is connected
through J12. In this case the JTAG debugger will sense the external power and debug the system without
providing its own power.
For power configuration diagram, see Figure 12.
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Figure 12. Debugger Power Configuration – USB eZ-FET and JTAG
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External Power Supply
An extra header J12 is present on the board to supply external power. When supplying external power,
jumper J10 must be set to "External." It is important to understand the device voltage operation
specifications when supplying external power. The MSP430FR5969 has an operating range of 1.8 V to 3.6
V. More information can be found in the device data sheet.
For power configuration diagram, see Figure 13.

2.4.4

BoosterPack
In some use cases it might be required to power the board from a BoosterPack. When powered from a
BoosterPack, the BoosterPack voltage should be across J4 Pin 1 (Vcc) and J5 Pin 20 (GND). This
complies with the BoosterPack pinout shown in Section 2.5. These pins are connected directly to the
FR5969 target device, and do not require any specific jumper configuration. Header J1 also provides
power directly to the target device.
Because J1 and the BoosterPack headers are connected directly to the target device Vcc, there are two
primary consequences:
• The super cap cannot charge through J11. Use of the super cap with this power scenario is not
recommended.
• Current of the target device through J9 cannot be measured. It is best to remove J9 in this scenario to
prevent back-powering of any additional circuitry such as the eZ-FET.
For power configuration diagram, see Figure 13.
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Figure 13. External Power Configuration – External and BoosterPack
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2.4.5

Super Cap
A 100-mF (0.1-F) super cap is mounted onboard and allows powering the system without any external
power. This highlights the ultra-low power of the MSP430FR5969 target device. See how long you can run
your application on the super cap alone!

2.4.5.1

Charging the Super Cap

To charge the super cap, jumper J11 is used. By default there is no jumper across J11. Place a jumper
across J11 to charge the super cap. If another jumper is not handy, the GND jumper on the isolation
jumper block can be used- as this jumper doesn't actually disconnect the GND connection.
To charge the super cap, power must be coming from a debugger (eZ-FET or JTAG) or external power
through J10. External power through J1 or a BoosterPack will not charge the super cap through J11.
Placing a jumper across J11 will charge the super cap when there is 3.3-V Vcc present, regardless of the
state of the Bypass/Use J2 jumper, however if J2 is in the "Bypass" state, changing it over to the "Use"
state will remove power from the target MSP430FR5969 and it will be reset.
2.4.5.2

Using the Super Cap

To use the super cap to power the LaunchPad, first change the J2 jumper to select "Use" and then set a
jumper on J11 to charge the super cap. After waiting for it to charge, any external power can be removed
from the system, and it will be powered completely by the super cap.
To remove any additional power drain from the super cap, remove any jumper to disconnect power to any
external source. This can be J11, J10, or J13 depending on the power configuration. This prevents the
super cap from back-powering the debug circuitry or any external power circuitry connected.
The most effective method for charging the capacitor is outlined in the following steps. These steps
assume the LaunchPad is powered by USB cable through the eZ-FET debugger.
1. Set "Power Selector" jumper (J10) to "Debugger" position.
2. Set jumper J2 to "Use" super cap position.
3. Set jumper J11 to "Charge" super cap position.
4. Set "V+" jumper J13.
5. Connect board to PC with USB cable.
6. Allow two to three minutes for the super cap to charge (time may vary depending on initial charge of
the super cap) to full VCC.
7. Remove the "V+" jumper J13.
For power configuration diagram, see Figure 14.
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Figure 14. Super Cap Power Configuration – Charging and Running Standalone

2.4.5.3

Disabling the Super Cap

To disable the super cap, change J2 to "Bypass," and remove jumper J11 to prevent additional current for
charging the super cap. With these two jumper selections, the super cap is completely disconnected from
the system.

2.5

BoosterPack Plug-in Module Headers
The BoosterPack headers allow for a variety of applications to be created by plugging BoosterPacks onto
the LaunchPad. BoosterPacks cover a wide range of possible applications including wireless connectivity,
environmental sensing, and LCD displays. Leverage the growing BoosterPack ecosystem to rapidly
prototype nearly any application with the LaunchPad rapid prototyping platform. Available BoosterPacks
can be found at www.ti.com/boosterpacks.
The FR5969 LaunchPad adheres to the 20-pin LaunchPad pinout standard. A standard was created to aid
compatibility between LaunchPad and BoosterPack tools across the TI ecosystem.
The 20-pin standard is compatible with the 40-pin standard used by other LaunchPads like the MSPEXP430F5529LP. This allows some subset of functionality of 40-pin BoosterPacks to be used with 20-pin
LaunchPads.
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While most BoosterPacks are compliant with the standard, some are not. The FR5969 LaunchPad is
compatible with all 20-pin BoosterPacks that are compliant with the standard. If the reseller or owner of
the BoosterPack does not explicitly indicate compatibility with the FR5969 LaunchPad, you should
compare the schematic of the candidate BoosterPack with the LaunchPad to ensure compatibility. Keep in
mind that sometimes conflicts can be resolved by changing the FR5969 device pin function configuration
in software. More information about compatibility can be found at http://www.ti.com/launchpad.
Figure 15 shows the 20-pin pinout of the FR5969 LaunchPad.
Note that software's configuration of the pin functions plays a role in compatibility. The FR5969
LaunchPad side of the dashed line shows all of the functions for which the FR5969 device's pins can be
configured. This can also be seen in the MSP430FR5969 data sheet. The BoosterPack side of the dashed
line shows the standard. The FR5969 function whose color matches the BoosterPack function shows the
specific software-configurable function by which the FR5969 LaunchPad adheres to the standard.
Below are the pins exposed at the BoosterPack connector
Also shown are functions that map with the BoosterPack standard.
* Note that to comply with the I2C channels of the BoosterPack standard, a software-emulated I2C must be used.
** Some LaunchPads do not 100% comply with the standard. Please check your LaunchPad to ensure compatability.
(!) Denotes I/O pins that are interrupt-capable.

BoosterPack
Standard

MSP-EXP430FR5969 Pin Map

+3.3V
Analog In
RX
UART
TX
GPIO (!)
Analog In
SPI CLK
GPIO (!)
SCL
I2C*
SDA

UCA1SOMI UCA1RXD
UCA1SIMO UCA1TXD
C11

A7

UCA1CLK
UCB0CLK
SMCLK
COUT

A1h
TB0.1
TB0.0
A11
TA1.0
TB0.2
TB0.3
TB0.4
TB0.5

(!)
(!)
(!)
(!)
(!)
(!)
(!)
(!)
(!)

+3.3V
P4.2
P2.6
P2.5
P4.3
P2.4
P2.2
P3.4
P3.5
P3.6
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GND
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TA0CLK
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SPI CS Wireless
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SPI CS Other

GND
GPIO (!)
GPIO (!)
GPIO**
RST
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SPI
MISO
GPIO (!)
GPIO (!)
GPIO (!)

Figure 15. FR5969 LaunchPad to BoosterPack Connector Pinout

2.6

Design Files
A complete schematic is available in Section 6. All hardware design files including schematics, layout, bill
of materials (BOM), and Gerber files are available in the MSP-EXP430FR5969 Hardware Design Files.
The software examples are made available in the MSP-EXP430FR5969 Software Examples. For more
information on the software examples, see Section 3.
The MSP-EXP430FR5969 LaunchPad was designed in Mentor Graphics PADS schematic and layout. A
free viewer is available to see both the schematic and layout files on the Mentor Graphics website at
http://www.mentor.com/pcb/downloads/pads-pcb-viewer. A full time-limited version of PADS is available
online for free. This version has complete functionality until the 30 day license expires. This version can be
downloaded directly from http://www.mentor.com/pcb/product-eval/pads-download-evaluation.
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Hardware Change log
Table 4 shows the hardware revision history.
Table 4. Hardware Change Log
PCB Revision

3

Description

Rev 1.6

Initial Release

Rev 2.0

Added EnergyTrace functionality, extended PCB dimensions, added mounting holes, updated isolation block
order, added 5V BP pin, updated silkscreen

Software Examples
There are three software examples included with the FR5969 LaunchPad, which can be found in the
MSP-EXP430FR5969 Software Examples. Table 5 describes these examples.
Table 5. Software Examples
Demo Name

BoosterPack Required

OutOfBox_FR5969

3.1

Description

More Details

The out-of-box demo pre-programmed on the LaunchPad from
the factory. Its function was described in Section 1.4.
Demonstrates features of MSP430FR5969 ULP FRAM device.

Section 3.3

430BOOSTSHARP96_ULP_FRAM

430BOOST-SHARP96

Demonstrates features of MSP430FR5969 ULP FRAM device
with various application modes.

Section 3.4

430BOOSTSHARP96_GrlibDisplay

430BOOST-SHARP96

A very simple example showing how to use MSP430 Graphics
Library (grlib) to display graphics primitives and images.

Section 3.5

MSP430 Software: Driver Library, Graphics Library, and Capacitive Touch Library
The examples are built upon three MSP430 libraries available from TI shown below. All three libraries are
available as part of MSP430Ware. Downloading CCS will include MSP430Ware along with TI Resource
Explorer.
• Driver library (driverlib): a foundational MSP430 software library, useful for interfacing with all MSP430
core functions and peripherals, especially clocks and power.
• Graphics library (grlib): a library for interfacing MSP430 devices to dot-matrix LCD displays. Contains
primitives for simple drawing as well as images and more.
• Capacitive Touch Library: a library for capacitive touch sensing applications. This library supports the
use of buttons, sliders, wheels and more. Highly configurable for each application.
When you begin your own development, you will need more information about these libraries than can be
included in this User's Guide. All the information you need is in MSP430Ware or specific library
documentation linked above.
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3.2

Development Environment Requirements
To use any of the below software examples with the MSP430FR5969 LaunchPad, you must have an
integrated development environment (IDE) that supports the MSP430FR5969 device.
Table 6. IDE Minimum Requirements for MSP430FR5969
Code Composer Studio™ IDE

IAR Embedded Workbench™ IDE

CCS v5.5 or later

IAR EW430 v5.60 or later

For more details on where to download the latest IDE, see Section 4.3.
3.2.1

Pre-Compiled Binary
The /Binary/ folder inside the MSP-EXP430FR5969 Software Examples includes pre-compiled TI-TXT
binary files for each of the above projects that are ready to be flashed onto the LaunchPad. A copy of the
MSP430Flasher tool is also shipped to interface with the eZ-FET Emulator.
To quickly program a demo onto the LaunchPad, simply navigate into the corresponding demo project's
directory and double click the "Program <Example>.bat" file.

Figure 16. Program <Example>.bat
If desired, the "Program <Example>.bat" file can be modified to point to your own project's binary file.
NOTE: After importing and compiling the software source code in an IDE such as CCS or IAR, the
TI-TXT binary files located in the /Binary/ folder will not be updated automatically. You must
copy your newly compiled binary from your IDE's /Workspace/Project/ directory and replace
the "<Example>.txt" in /Binary/ for the batch file to program your own binary file.
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CCS
CCS v5.5 or higher is required. When CCS has been launched, and a workspace directory chosen, use
Project→Import Existing CCS Eclipse Project. Direct it to the desired demo's project directory containing
main.c. This is one of the OutOfBox_FR5969, 430BOOST-SHARP96_ULP_FRAM, or 430BOOSTSHARP96_GrlibDisplay projects (see Figure 17).

Figure 17. Directing the Project→Import Function to the Demo Project
Selecting the \CCS or \CCS_Code_Size_Limited folder also works. The CCS-specific files are located
there.
When you click "OK", CCS should recognize the project and allow you to import it. The indication that
CCS has found it is that the project appears in the box shown in Figure 18, and it has a checkmark to the
left of it.
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Figure 18. When CCS Has Found the Project
Sometimes CCS finds it but does not have a checkmark; this might mean that a project by that name is
already in the workspace. Rename or delete that project to resolve this conflict. (Even if you don't see it in
the CCS workspace, be sure to check the workspace's directory on the file system.)
3.2.3

IAR
IAR Embedded Workbench™ IDE v5.60 or higher is required. To open the demo in IAR, simply choose
File→Open→Workspace…, and direct it to the *.eww workspace file inside the \IAR subdirectory of the
desired demo. All workspace information is contained within this file.
The subdirectory also has an *.ewp project file; this file can be opened into an existing workspace, using
Project→Add-Existing-Project….
Although the software examples have all the code required to run them, IAR users may wish to download
and install MSP430Ware, which contains driverlib, grlib, capacitive touch library, and the TI Resource
Explorer. These are already included in a CCS installation (unless the user selected otherwise).

3.3

Out-of-Box Software Example
This section describes the functionality and structure of the out-of-box software that is preloaded on the
EVM.
The full out-of-box demo cannot be built with the free version of CCS or IAR (IAR Kickstart) due to the
code size limit. To bypass this limitation, a code-size-limited CCS version is provided, that has most
functionality integrated into a library. The code that is built into the library is able to be viewed by the user,
but it cannot be edited. For full functionality download the full version of either CCS or IAR.
There are two modes in the out-of-box software, which can only be interacted with using the provided GUI
in the MSP-EXP430FR5969 Software Examples.
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Source File Structure
The project is organized in multiple files. This makes it easier to navigate and reuse parts of it for other
projects. Table 7 describes each file in the project.
Table 7. Source Files and Folders

3.3.2

Name

Description

main.c

The out-of-box demo main function, initializations, shared ISR's, etc

LiveTempMode.c

Main function file for live temperature streaming mode

FRAMLogMode.c

Main function file for FRAM data logging mode

Library: Driverlib

Device driver library (MSP430DRIVERLIB)

Power Up and Idle
When the out-of-box demo powers up, the red and green LEDs toggle several times. The MSP430FR5969
then enters low-power mode 3 to wait for UART commands from the PC GUI.
The GUI that is included in the MSP-EXP430FR5969 Software Examples download is required to connect
to the serial port that the LaunchPad's UART communication uses. Follow the "Setup" instructions in the
GUI to establish the connection. After connection has been established, the GUI pings the LaunchPad
every few seconds to make sure that it is still present. If no response is received from the LaunchPad, the
GUI automatically closes the serial port connection.

3.3.3

Live Temperature Mode
To enter the live temperature mode, click the "Start" button below "Live Temp Mode" in the GUI's
Application Controls panel (see Figure 19).

Figure 19. Live Temperature Mode
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The MSP430FR5969 first sends two calibration constants for the temperature sensor to the PC GUI. It
then sets up its 12-bit ADC for sampling and converting the signals from its internal temperature sensor. A
hardware timer is also configured to trigger the ADC conversion every 0.125 seconds before the device
enters low-power mode 3 to conserve power. As soon as the ADC sample and conversion is complete,
the raw ADC data is sent the through the UART backchannel to the PC GUI.
As the raw ADC data is received by the PC GUI, Celsius and Fahrenheit units are calculated first. The PC
GUI keeps a buffer of the most recent 100 temperature measurements, which are graphed against the
PC's current time on the Incoming Data panel.
A red horizontal line is drawn across the data plot to indicate the moving average of the incoming data.
To exit this mode, click the "Stop" button under "Live Temp Mode". You must exit this mode before
starting the FRAM Log Mode.
3.3.4

FRAM Log Mode
To enter the FRAM Log Mode, click the "Start" button under "FRAM Log Mode" in the GUI's Application
Controls panel. The PC GUI immediately sends the current system timestamp to be stored in the
LaunchPad. This timestamp is later used to extrapolate the X-axis time values when the FRAM logged
data are transferred to the GUI (see Figure 20).

Figure 20. FRAM Log Mode
When the MSP430FR5969 receives the UART command from the GUI, it starts the entry sequence by
initializing the Real-Time Clock to trigger an interrupt every 5 seconds. The red LED blinks three times to
indicate successful entry into FRAM Log Mode.
Unlike in the Live Temperature Mode, the MSP430FR5969 enters low-power mode 3.5 to further decrease
power consumption and wakes up every 5 seconds to perform data logging. Because the UART
communication module does not retain power in LPM3.5, the GUI automatically disconnects from the
LaunchPad after entry into FRAM Log Mode.
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Each time the device wakes up, the green LED lights up to indicate its state to the user. The 12-bit ADC is
set up to sample and convert the signals from its internal temperature sensor and battery monitor (Super
Cap voltage).
A section of the device's FRAM is allocated to store the raw ADC output data (address 0x9000 to
0xEFFF). This allows the demo to store up to 6144 temperature and voltage data points (5
seconds/sample is approximately 8.5 hours of data).
The FRAM Log Mode also provides the option to log temperature data while powered either through the
USB cable or only by the on-board Super Cap. The PC GUI contains step-by-step instructions in its side
panel for configuring the jumpers on the LaunchPad to power the device with the Super Cap. See
Section 2.4.5 for more detail on the Super Cap.
To exit the FRAM Log Mode, press the S2 (right) push button on the LaunchPad. The red LED turns on
briefly to indicate successful exit. The LaunchPad returns to the Power up and Idle state, and you can
reconnect the LaunchPad with the GUI to transfer the logged data from FRAM to the PC. Click the
"Transfer FRAM Data" button in the GUI to begin transfer. A progress bar shows progress until the
transfer completes, and the temperature and voltage data are plotted in the Incoming Data panel.

3.4

430BOOST-SHARP96 ULP FRAM Demo
This section describes the functionality and structure of the 430BOOST-SHARP96 ULP FRAM demo that
is included in the MSP-EXP430FR5969 Software Examples.
NOTE: The 430BOOST-SHARP96 ULP FRAM demo relies on the 430BOOST-SHARP96
BoosterPack and has a very limited use without it.

The full demo source code cannot be built with the free version of CCS or IAR (IAR KickStart) because of
the code size limit. To bypass this limitation, a code-size-limited CCS version is provided that has most
functionality integrated into a library. The code that is built into the library can be viewed by the user, but it
cannot be edited. For full functionality, download the full version of either CCS or IAR.
There are five applications in the demo software. All of them are in one project and the different
applications can be cycled through in the user interface.
3.4.1

Source File Structure
The project is split into multiple files. This makes it easier to navigate and reuse parts of it for other
projects.
Table 8. Source Files and Folders
Name

28

Description

Main.c

The user experience demo main function, shared ISRs, and other functions

ActivePowerMeasure.c

Main function file for Active Mode Power app

ClockApp.c

Main function file for Clock app

FR59xx_EXP.c

File for handling system init, main menu, and button operations

FRAMSpeedApp.c

Main function file for FRAM Speed app

Game.c

Main function file for SliderBall video game app

SYS.c

Functions to enter and exit LPM3.5

myTimer.c

Contains all timer-based functions and interrupts

ULPMeter.c

Main function file for Battery Free Stopwatch app

Library: CTS

Capacitive Touch Software Library (CAPSENSELIBRARY)

Library: Driverlib

Device driver library (MSP430DRIVERLIB)

Library: grlib

Graphics library for the SHARP LCD (MSP430-GRLIB)

Folder: Preloaded images

Images for the LCD screen
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3.4.2

Navigation and Main Menu
Upon powering up the demo, the title screens appear on the LCD, and are followed by the main selection
menu. The main menu displays all the applications available in the demo. The application options in the
menu are highlighted by using the left capacitive touch slider.
NOTE: Only the left capacitive touch slider is activated for navigation.

After an application is selected, the right button (S2) is used to enter the application. To change the
application or exit, use the left button (S1) and then navigate the main menu to switch to a different
application.
3.4.3

Clock Application
NOTE: This application relies on the operation of the 32.768-kHz clock crystal that is pre-populated
on the LaunchPad.

To enter this application, highlight the "Clock" option on the main menu and then push the right button
(S2).
Immediately upon entering the Clock app, the user is expected to set the date and time details before the
clock starts running. This needs to be done every time the application is entered, because the clock
values are not maintained when running any of the other applications. To set the time and data
parameters use the following steps:
1. When the app starts, the parameter being modified begins to blink.
2. The left capacitive touch slider can be used to increment or decrement the blinking parameter by
placing a finger on the top or bottom portion, respectively, of the slider.
3. The value of the blinking parameter can be locked by placing a finger in the middle of the left
capacitive touch slider.
4. The parameter that is being modified can be changed with the right button (S2).
5. Repeat steps 2 to 4 until all parameters have been set, after which the clock resets the seconds and
begins to track the time from the set time and date.
When the clock begins to run, note that an option to turn on or off the seconds display is provided using
the left button (S1). This is useful when attempting to measure power. The device spends most of the time
in standby (LPM3), waking up every one second to update the RTC values. However if the display is
updated every second, the average power is much higher than just the LPM3 power due to time and
energy required to modify the LCD through SPI. If the SecON option is turned off, the device continues to
provide a one second wakeup to update the RTC values but the display is updated only once a minute to
save power. In this configuration the device power will be similar to power in LPM3 (refer device data
sheet for exact values).
When attempting to measure power using the Current jumper J9, ensure that the meter is in place before
the board is powered up. Removing this jumper while the application is running results in a power cycle of
the device (because the connection to VCC is broken), and the clock parameters must be re-entered.
3.4.4

FRAM Speed Application
To enter the FRAM Speed app, the "FRAM Speed" option on the main menu must be highlighted and the
right button (S2) then pushed. In this application, the FRAM write speed (in kilobytes per second), the total
data written to FRAM (in kilobytes), and the FRAM endurance (in percentage) is tracked and displayed on
the LCD. No user interaction is required.
The application uses Direct Memory Access (DMA) to transfer data to a 1KB block of FRAM. The starting
address of this block is defined and can be modified within the FRAMSpeedApp.h file. Note that changing
this location can cause an overlap with other application code. This is not advised, because code may be
overwritten while running the application. Hence special care needs to be taken to evaluate the size of the
code to ensure that it is not over-written while measuring the FRAM write speed.
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It should be noted that this application is optimized for speed rather than power. The speed of this
application is approximately 7500KB (7.5MB) per second. On a flash device, the achievable speed would
be approximately 13KB per second.
Larger blocks of data can be written, which results in faster write speeds but also higher power
consumption. For more information on how to optimize FRAM write speeds, refer to the application report
Maximizing FRAM Write Speed on the MSP430FR57xx (SLAA498).
In this application, the system main clock is configured to use the DCO at 8 MHz. The application
configures the DMA transfer of data and continuously executes it while remaining in LPM0. Each time the
DMA writes the 1KB block, a count variable is incremented and the next DMA transfer is triggered. A timer
is set up to interrupt the FRAM writing every 0.25 second to calculate the speed, total the kilobytes of data
written, update the endurance, and then output these parameters on the LCD.
Note that the FRAM endurance percentage is retained after a power cycle. To exit the application and
stop the FRAM writes, the left button (S1) can be pushed allowing the user to return to the main menu.
3.4.4.1

Understanding the Numbers Behind the FRAM Speed Application

The LCD is updated every 250 ms with an updated percentage change in the FRAM endurance. To
calculate the endurance, some approximations were made in order to provide a meaningful output on the
LCD.
Every 250 ms, 1.8MB of FRAM are programmed with a pattern. Hence the speed of FRAM writes is
calculated as 7.564 MB/s. The FRAM is written to in blocks of 1K bytes; it is this 1KB block that is subject
to the lifetime FRAM endurance specification.
FRAM endurance of block = E = 1015 write cycles. This is a minimum specification for FRAM endurance
found in the device data sheet.
Table 9. FRAM Endurance Calculation for 1KB Block of FRAM
Derived From

Value

E

FRAM endurance

Variable

Data sheet

1015 writes

W

Write speed

Application

7.564 MB/second

B

FRAM block size

Application

1KB (1024 bytes)

N

Number of writes to a unique byte/sec

N=W/B

7386 writes/second

TLCD

Time between LCD updates

Application

250 ms

TLIFE

Time until endurance specification is met

TLIFE = E / N

1.35 × 1011 seconds
(more than 4000 years)

L

Lifetime percentage reduction per LCD update

L = (TLCD / TLIFE) × 100

1.85 × 10-10%

The calculated value of L is rounded up to 2 × 10-10%, or 0.0000000002%. This is the amount the FRAM
endurance is decremented on the LCD every 250 ms.
Note that the FRAM endurance percentage is retained during on a power cycle. This parameter is
preserved by storing it in FRAM and preventing the variable from being overwritten on a power cycle.
Refer to the NO INIT and LOCATION pragmas in the CCS compiler documentation for more details. This
parameter will be reset when the device is reprogrammed, and the address overwritten.
3.4.5

Battery Free Application
To enter the Battery Free Stopwatch application, select the "Battery Free" option on the main menu and
then press the right button (S2).
This mode is intended to be used when running from the super cap only. See Section 2.4.5 for more
information on how to power the LaunchPad from the super cap.
When the application is entered, a submenu appears showing two possible actions to be taken. The first
action is to "Run App," which starts the Battery Free Stopwatch application and log . The other option is to
"Transmit Data", which transmits all logged data from previous runs through the MSP430 UART to a PC.
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The "Run App" selection has four modes:
1. Title Mode (Warning Page)
2. Deep Sleep -LPM3.5 Mode
3. Display Mode
4. Low Battery Indicator Mode
When in Title mode or Display mode, press the right button (S2) to put the device into LPM3.5 (Deep
Sleep Mode). Also in these two modes, press the left button (S1) at any time to exit the app and return to
the main menu.
When in Deep Sleep mode, the device remains in LPM3.5, and only the RTC is active. The left button
(S1) is deactivated while in this mode, and the right button (S2) can be used to wake the device from
LPM3.5 and send the device into Display mode. Also, in this mode the RTC wakes up the device
periodically to allow the ADC to sample the supply voltage before returning to LPM3.5. These ADC
samples of the supply voltage are logged into FRAM and can be transmitted back to a PC in the "Transmit
Data" mode.
The Display mode shows the stopwatch display and also the charge consumed while in LPM3.5. The
stopwatch is started when the device enters LPM3.5 and stopped on exit. Hence the total time spent in
LPM3.5 is displayed in HH:MM:SS format. The charge indicator is a reflection of the most recent ADC
sample of supply voltage. If the device is left inactive at the "Display Mode" screen for more than ten
seconds, the app times out, and control reverts to the main menu.
Low Battery mode is entered conditionally following an ADC measurement of the supply voltage. When
VCC < 2.2 V, the device displays a "Low Battery" warning screen. The screen recommends that the device
be plugged into the PC through USB for charging. In this mode, the left button (S1) is deactivated, and the
right button (S2) is used to check if USB has been plugged in or not. If the device has not been plugged
into USB and the right button (S2) is pushed, the device remains in Low Battery mode. If the device has
been plugged into USB and the right button (S2) is pushed, the device enters Deep Sleep mode again.
When running this application, the ADC measurements are logged in FRAM while the device is running
from the super cap indicating that the ADC sampling and FRAM write have a very low-power footprint.
These logged values can then be sent to the PC and the data processed to analyze the reduction of
charge over time. The transfer of data can be done in the UART transmit mode.
The basic operation of the UART transmit mode is outlined below.
1. The eUSCI-UART and DMA modules are set up to transfer the data from FRAM.
2. "Sending Data – Please Wait" screen is displayed while the operation is in progress.
3. On completion "Data Send Complete" screen is displayed.
4. The data can be viewed using any hyperterminal application on the PC.
3.4.6

Active Power Application
The active power of the MSP430FR5969 device is directly dependent on the code and data cache hit ratio
and the clock speed of the CPU. The Active Power application shows the impact of both these factors on
overall system power.
To measure the power consumption of the MSP430FR5969 for the different frequencies and cache hit
ratios, the following steps should be followed:
1. Remove the "Measure Current" jumper from the LaunchPad
2. Use an ammeter set to the "mA" range and connect the leads of the ammeter to the nodes of the
"Measure Current" jumper
3. Navigate the main menu to the "Active Mode" app
4. Choose a frequency and cache hit ratio from the subsequent menus
5. Press the right button (S2) to enter the cache hit code
6. Tune the ammeter range to obtain the most accurate current measurement values
7. Prior to exiting the cache hit code, ensure that ammeter is in "mA" range, then press right button (S2)
to exit cache hit code

SLAU535B – February 2014 – Revised July 2015
Submit Documentation Feedback

MSP430FR5969 LaunchPad™ Development Kit (MSP‑EXP430FR5969)

Copyright © 2014–2015, Texas Instruments Incorporated

31

Software Examples

3.4.7

www.ti.com

SliderBall Game
This application was designed to show the functioning ability of the two Capacitive Touch sliders in
conjunction with the LCD from the 430BOOST-SHARP96 BoosterPack.
To enter the application, the SliderBall game option on the main menu must be highlighted and the right
button (S2) then pushed. The SliderBall game requires the player to use a sliding paddle to keep the ball
in play. The goal of the game is to keep the ball alive and on the screen by having it hit off of the two
paddles at each end of the screen. Users start off with five lives to accumulate as many points as
possible. For each time that the ball is blocked by the paddle, points are awarded. The higher the
difficulty, the more points are awarded for each hit. Each time the ball reaches the end of the screen and
the paddle has not hit the ball, the user loses a life. After the life is lost, the ball automatically starts again
for another round. This repeats until all lives are exhausted, and the game is over. If the high score has
been achieved, a congratulations screen will be displayed to notify the user. At this point the final score,
as well as the board high score will be displayed and the user may then choose a new level of difficulty to
play once again.
To navigate the user levels menu and choose an option, the left capacitive touch slider and right button
are used similar to all previous menus. The user may choose between the following: easy, normal, hard,
and Insane. After selecting a difficulty, the game will begin to start, with the ball moving to the right-hand
side first. Both capacitive touch sliders are used to control their respective paddles along the side of the
screen. When the user misses the ball, it will be held in place for a few cycles before starting to move
again to give the user a chance to regroup following losing a life. To create "easier" versions of the game,
sleep cycles are added to slow down the game play.
The high score for each user level is stored in FRAM and is retained on subsequent power cycles. This
value is erased only when the device is re-programmed.

3.4.8

Special Notes: Inverting the Display Color Scheme
A feature that has been built in to the demo code is the ability to invert the display colors. This can be a
useful feature for times when the original display color settings are difficult to read.
To invert the colors edit the file 'sharp96x96.h' within the 'grlib' directory. In the 'User Configuration for the
LCD Driver' section under 'Invert Display Option' use either one of the # defines 'NORMAL_DISPLAY' or
'INVERT_DISPLAY' as needed.
When INVERT_DISPLAY is defined it allows the demo to display with a black background and white
foreground once the demo code is re-downloaded onto the MSP-EXP430FR5969 board.

3.5

430BOOST-SHARP96 Graphics Library Demo
NOTE: This graphics library demo is dependent on the 430BOOST-SHARP96 BoosterPack that
comes with the MSP-BNDL-FR5969LCD bundle.

The grlib demo shows how to use the MSP430 Graphics Library http://www.ti.com/tool/msp430-grlib or
"grlib," in a project with the Sharp® display. This demo cycles screens without user interaction to show
simple graphics primitives.
• Pixels
• Lines
• Circles
• Rectangles
• Text
• Images
The demo introduces the functions to configure grlib such as initialization, color inversion, and using
foreground and background colors properly.
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FRAM memory devices like the MSP430FR5969 are touted for ultra-low power, but in some applications
the FRAM memory can provide additional benefits such as dynamic memory allocation. In applications
with dot matrix LCD displays, it is often advantageous to keep a RAM buffer of the contents currently on
the display. For a smaller display such as the Sharp display on the 430BOOST-SHARP96 BoosterPack,
this doesn't require much RAM to keep the display contents.
96 LETAHO/NKS
4#/ >UPAO NAMQENA@ =
× 96 NKSO = 1152 >UPAO
8 LETAHO/>UPA
(1)
But in displays with more pixels or color displays, these RAM buffers can quickly become very large. If the
Sharp display was a color display with 16 bits or color per pixel, (common in color displays) this buffer
would be significantly larger.
96 LETAHO/NKS
4#/ >UPAO NAMQENA@ =
× 96 NKSO = 18432 >UPAO
0.5 LETAHO/>UPA
(2)
When selecting a microcontroller for an application with a display like this would require a very large
memory device for a typical RAM/Flash microcontroller. Typical RAM memory cutoffs would likely require
a 32KB RAM device with around 128KB or 256KB of Flash. This may be significantly more memory than
the application requires.
FRAM's unified memory block can be dynamically partitioned into data or code memory, providing
unmatched flexibility. Applications like this can be easily supported with a 32KB or 64KB FRAM device.

Figure 21. FRAM Unified Memory With Dynamic Partitioning
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4

Additional Resources

4.1

LaunchPad Websites
More information about the FR5969 LaunchPad, supported BoosterPacks, and available resources can be
found at:
• FR5969 LaunchPad tool page: resources specific to this particular LaunchPad
• TI's LaunchPad portal: information about all LaunchPads from TI for all MCUs

4.2

Information on the MSP430FR5969
At some point, you will probably want more information about the FR5969 device. For every MSP430
device, the documentation is organized as shown in Table 10.
Table 10. How MSP430 Device Documentation is Organized
Document

4.3

For FR5969

Description

Device family user's
guide

MSP430FR58xx, MSP430FR59xx,
MSP430FR68xx, and MSP430FR69xx Family
User's Guide (SLAU367)

Architectural information about the device,
including clocks, timers, ADC, and other
peripherals.

Device-specific data
sheet

MSP430FR59xx, MSP430FR58xx Mixed Signal
Microcontroller data sheet (SLAS704)

Device-specific information and all parametric
information for this device

Download CCS, IAR, or MSPGCC
Although the files can be viewed with any text editor, 'more can be done with the projects if they're opened
with a development environment like Code Composer Studio (CCS), IAR, or Energia.
CCS and IAR are each available in a full version, or a free, code-size-limited version. The full source code
for some of the included example projects cannot be built with the free version of CCS or IAR (IAR
KickStart) due to the code size limit. To bypass this limitation, a code-size-limited CCS version is provided,
that has most functionality integrated into a library. The code that is built into the library is able to be
viewed by the user, but it cannot be edited. For full functionality download the full version of either CCS or
IAR.
See the MSP430 software tools page to download them, and for instructions on installation.
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4.4

MSP430Ware and TI Resource Explorer
MSP430Ware is a complete collection of libraries and tools. It includes a driver library (driverlib) and the
graphics library (grlib) used in the software demo. By default, MSP430Ware is included in a CCS
installation. IAR users must download it separately.
MSP430Ware includes the TI Resource Explorer, for easily browsing tools. For example, all the software
examples are shown in the tree below.

Figure 22. MSP-EXP430FR5969 Software Examples in TI Resource Explorer
Inside TI Resource Explorer, these examples and many more can be found, and easily imported into CCS
with one click.

4.5

MSP430FR5969 Code Examples
This is a set of very simple code examples that demonstrate how to use the MSP430's entire set of
peripherals: ADC12, Timer_A, Timer_B, and so on. These do not use driverlib, rather they access the
MSP430 registers directly.
Every MSP430 derivative has a set of these code examples. When writing code that uses a peripheral,
they can often serve as a starting point.
There are also code examples available that use driver library. These code examples are part of the
driverlib download included with MSP430Ware. To access these code examples, navigate into the
driverlib folder or use the TI Resource Explorer to import into CCS.

4.6

MSP430 Application Notes
There are many application notes at www.ti.com/msp430 with practical design examples and topics.
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The Community

4.7.1

TI E2E Community
Search the forums at e2e.ti.com. If you cannot find an answer, post your question to the community.

4.7.2

Community at Large
Many online communities focus on the LaunchPad – for example, http://www.43oh.com. You can find
additional tools, resources, and support from these communities.

5

FAQs
Q: I can't get the backchannel UART to connect. What's wrong?
A:
•
•
•

Check the following:
Do the baud rate in the host's terminal application and the USCI_A0 settings match?
Are the appropriate jumpers in place on the isolation jumper block?
Probe on RXD and send data from the host; if you don't see data, it might be a problem on the host
side.
• Probe on TXD while sending data from the MSP430. If you don't see data, it might be a configuration
problem on the USCI_A0 module.
• Consider the use of the hardware flow control lines (especially for higher baud rates)
Q: So the onboard emulator is really open source? And I can build my own onboard emulator?
A: Yes! We encourage you to do so, using the design files.
Q: The MSP430 G2 LaunchPad had a socket, allowing me change the target device. Why doesn't
this LaunchPad use one?
A: This LaunchPad provides more functionality, and this means using a device with more pins. Sockets for
devices with this many pins are too expensive for the LaunchPad's target price.
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STANDARD TERMS FOR EVALUATION MODULES
1.

Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software
1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2

Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM
to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.
2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

3

Regulatory Notices:
3.1 United States
3.1.1

Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2

For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.
FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:
•
•
•
•

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1

For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.
Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.
Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.
Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur
3.3 Japan
3.3.1

Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に
輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2

Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1.

2.
3.

Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,
Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or
Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1.
2.
3.

電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用
いただく。
実験局の免許を取得後ご使用いただく。
技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ
ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル
3.3.3

Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1

For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):
This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

4

EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.
4.3 Safety-Related Warnings and Restrictions:
4.3.1

User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2

EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.
5.

Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6.

Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.
6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7.

USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8.

Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.
8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9.

Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.
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Copyright © 2018, Texas Instruments Incorporated

IMPORTANT NOTICE AND DISCLAIMER
TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.
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